
Telephone: (502) 227-7270 

Gwen Pinson 
Executive Director 
Public Service Commission 
211 Sower Blvd. 
Frankfort, KY 40601 

Dear Ms. Pinson: 

JOHN N. HUGHES 
Attomey at Law 

Professional Service Corporation 
124 West Todd Street 

Frankfort, Kentucky 40601 

jnhughes@johnnhughespsc.com 

January 26,2018 

RECEIVED 

JAN 2 6 2018 

PUBLIC SERVICE 
COMMISSION 

Re: KY Frontier Gas Case No. 2018-00010 

Pursuant to the Order of January 22,2018, Kentucky Frontier Gas, LLC submits 
the information required of807 KAR 5:001(12)(2)(£). 

Please contact me if you have any questions about this matter. 

~i17rs, ~ 
~.Hug)l¥:; 

Attorney for KFG 

Attachments 



Kentucky Frontier Gas UC 

Lon& Term Debt Financing 

Monthly 
Maturity !~rest Original Interest Prln+lnt Current 

Loan Description Issue Date Date Rate Balance Loan Balance Paid In 2017 Payment Interest Pmt 

System Loans with Community Trust Bank: 4.50% I WSJ APR projected for January 2018 pmts 5.0'!61 threslwld for fixro SBAJI2 

SBA #1 Bei-EKU-MLG 12/30/2008 12/30/2018 5.00% 1,525,000 s 270,243 s 19,870 s 1,126 /mo PPmts $373,241 /yr 

USDA Ill Aux-Sig 4/13/2010 4/13/2025 6.00% s 1,571,760 s 949,009 s 13,277 s 4,745 
USDA 112 Aux-Sig 4/13/2010 4/13/2025 6.00% s 160,431 s 105,444 s 1,475 s 527 lnvestmt 7,313,000 GR17 Depr xis 

Depr 2,534,800 GR17 BB model 
SBAII2- BTU 7/23/2012 7/23/2027 6.259t; s 237,000 s 172,743 s 1,883 s 900 Bk Value 4,778,200 

SBA 113- Public 11/2/2015 11/2/2030 6.25% s 1,500,000 s 1,372,379 s 12,127 s 7,148 

Totals $ 4,994,191 $ 2,869,818 $ s 546,590 s 173,349 /yr Cllpltal Structure Owners Equity 
$ 48,633 $ 14,446 /mo Debt $ 2,870 6.0'!6 $173.35 $ 2,870 

Equity $ 1,908 10.0'!6 ~ 190.84 s 4,443 
wtd ave 6.04" $ 4,778 7.69t; s 364.19 7,313 

Auto Loans with Community Trust Bank: projected for January 2018 pmts WSJ WtdAv .. $k/yr 
Mar-17 4.00% 5.71~ s 171.2 

2015 Tacoma 4/22/2015 5/22/2020 2.99% s 20,000 s 10,157 s 341 s 365 $ 25 Sep-17 4.25~ 5.86% $ 175.9 
2015 Chevy 2500 1/31/2015 1/31/2020 299% $ 33,695 $ 15,282 s 606 s 610 s 38 Dec-17 4.50'!6 6.029t; s 180.7 
2016 Tacoma 1/14/2016 1/14/2021 2.99% $ 20,935 s 13,302 s 431 s 377 s 33 4.75% 6.18% s 185.4 
2015 Ford F350 svc 2/2/2015 2/2/2020 2.99% s 33,951 s 14,880 s 581 $ 614 s 37 5.~ 634% $ 190.2 
2017 Tacoma 12/6/2016 12/6/2021 2.999t; s 27,323 s 21,655 s 730 $ 496 s 54 5.25% 6.59% $ 197.7 USDAs off floor 

5.50% 6.84% s 205.2 
Totals $ 135,903 $ 75,276 $ 2,689 s 29,547 s 2,251 /yr 

$ 2,462 $ 188 /mo 

(WY of loll no CTB (003) JonlB 6/14/17 



Maturtty Interest Original 

Loan Description Issue Date Date Rate Balance 

Loans with Community Trust Bank: 4.00'J61 WSJ APR 

SBA #1 Bei-EKU-MLG 12/30/2008 12/30/2018 4~ $1,525,000 

USDA Ill Aux-Sig 4/13/2010 4/13/2025 6.00% $1,571,760 

USDA 112 Aux-Sig 4/13/2010 4/13/2025 6.0096 $160,431 

SBA 112- BTU 7/23/2012 7/23/2027 5.7596 $237,(XX) 

SBA #3- Public 11/2/2015 11/2/2030 5.7596 $1,500,(XX) 

Totals $4,994,191 

Q>py of l.ooru CT1l (003) Jul17 

Loan Balance 

Kentucky Frontier Gas UC 

Long Tenn Debt Financing 

Monthly 

Pr1n+lnt Current 

Payment Interest Pmt 

projected for July 2017 pmt 

$327,500 $19,870 $1,228 /mo 

$990,(XX) $13,277 $4,950 

$110,000 $1,475 $550 

$178,000 $1,883 $853 

$1,395,000 $12,127 $6,684 

$3,000,500 $546,590 $171,185 /yr 

$48,633 $14,265 /mo 

wtdave 5.71" 

5.0~ I threshold for fixed SBAJI2 

PPmts $375,405 /yr 

lnvestmt 7,313,000 

Depr 2,534,800 
Bk Value 4, 778,200 

Capital Structure 

Debt $ 3,001 5.796 

Equity $ 1,778 10.0% 

$ 4,778 7.396 

WSJ WtdAve 

Mar-17 4.0096 5.7196 

Sep-17 4.2596 5.8696 

Dec-17 4.5096 6.0296 

4.75~ 6.18% 

5.0096 6.3496 

5.2596 6.5996 

5.50% 6.8496 

GR17 Depr xis 

GR17 BB model 

$ 171.19 

$ 177.77 

$ 348.96 

$1r/yr 
$ 171.2 

$ 175.9 

$ 180.7 

$ 185.4 

$ 190.2 

Owners Equity 

$ 3,001 

$ 4,313 

7,313 

$ 197.7 USDAs off floor 

$ 205.2 

6/14/17 
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PAYMENT QUOTE.xlu 

An1ortizntion Table 
The amortization table at the end of this worksheet calculates the principal and interest payments, ending balance, 
and cumulative Interest for any 40 consecutive payment periods of a loan. 
+ To use the table, change the values In the lnltal Data section of the worksheet. 
+ TQ print the table, choose Print from the File menu. The print area Is set to A 1 :G77. 

+ If you increase the term of the loan or the number of payments, you will need to add more payment periods 
to the table. Select cells A75:G77, then drag the Fill handle (f-) Into the cells below the table. 

+ Most formulas on this worksheet are contained in defined names. To see the names· and formulas, 
choose Name from the Insert menu, and then choose Define. Select a name from the list 
('Amortization lable'llnteresl, for example). 

Loan amount: $20,278.00 
Annual Interest rate: 2.99% 

Term In years: 5 
Payments.per year: 12 868.7109959 
First payment due: 3/1/2010 

PERIODIC PAYMENT 
Entered payment: 

Calculated payment: $364.28 

CALCULATIONS 

The table uses the calculated periodic payment amount, 
unless you enter a value for "Entere.d payment." 

\ \ 

'-)-.. · 

\. , ... ..:v 

Use payment of: 
1st payment in table: 1 

$364.28 Beginning balance at payment 1: 
Cumulative lntere51 prior to payment 1: 

$20,278 .00 
$0.00 

Payment Beginning Ending Cl.lmulatlve 
No. Date Balance lntera!!t Princif!al Balance Interest 
1 3/1/20n 20,278.00 50.53 313.75 19,964.25 50.53 
2 4/1/20 0 19,984.25 49.74 314.53 19,649.71 100.27 ~9/1/2q'1 0 3 19,849.71 48.96 315.32 19,334.39 149.23 
4 l ~/1/2~1 0 19,334.39 48.17 316:10 19,018.29 197.41 
5 I :\~'2 10 1 9;CJt 8.29 47.39 316.89 18,701.40 244.79 
6 ! 8 11~010 18,701.40 46.80 317.68 18,383.72 291 .39 
7 l 9~x. 010 18,383.72 45.81 318.47 18,066.24 337.20 
8 \10/,,( ~010 18,085.24 45.01 319.27 17,745.98 382.21 
9 ~ 1/11, 2010 17,745.98 44.22 320.06 17 425.92 428.43 

10 12/120~ 17,425.92 43.42 320.66 17,105.06 469.85 
11 ~ /1/ 01 17.105.08 42.82 321.88 16,783.40 612.47 
12 2/1 011 16,783.40 41 .62 322:-46 16,460.94 554.28 
13 3~~~01J' 16,460.94 41 .02 323.26 16,137.67 595.30 
14 4/ /201,11 16,137.67 40.21 324.07 15,813.80 635.51 
15 5/1/2'Q~ 1 15,813.60 39.40 324.88 15,488.73 674.91 
16 611129\1 15,488.73 38.59 325.69 15,163.04 713.50 
17 7/,n/2911 15,163.04 37.78 326.50 14,836.54 751 .29 
18 8i1/~011 ~. -·- 14.836.54 36.97 327.31 14,509.23 788.26 
19 9/1/t011 14.509.23 36.15 328.13 14,181 .10 624.41 
20 10~~2011 14,181.10 35.33 328.94 13,852.16 859.74 
21 111 1/2011 13,852.16 34.51 329.76 13,522.40 894.26 
22, 12/1/2011 13,522.40 33.69 330.59 13,191.81 927.95 
23 1/1/2012 13,191.81 32.87 331.41 12,860.40 960.82 
24 2/1/2012 12,860.40 32.04 332.24 12 ,528.17 992 .86 

Page 1 

U98-988-909 f.lJnqSUOISSJd 818 



PAYMENT QUOTE.xls 
Paymant Beginning Ending cumulatlva 

No. Date Balanca Interest Prlnolpol Balano11 Interest 
25 3/1/2012 12,628.17 31.22 333.06 12,195.10 1,024.08 
26 4/1/2012 12,195.10 30.39 333.89 11,881.21 1,054.46 
27 5/1/2012 11,861.21 29.65 334.72 11 526.49 1 084.02 
26 6/1/2012 11,528.49 28.72 335.66 11,190.93 1,112.74 
29 7/112012 11,1130.93 27.88 338.39 10,864.53 1,14D.62 
30 8/1/2012 10,654.53 27,06 337.23 10 517.30 1187.67 
31 9/1/2012 10,517.30 26.21 338.07 10,179.22 1,193.87 
32 10/1/2012 10,179.22 25.36 338.92 9,840.31 1,219.24 
33 11/1/2012 9,840.31 24.62 339.76 9 600.66 1 243.76 
34 121112012 9,500 . .Sel 23.67 340.61 9,159.94 1,267.43 
35 1/112013 9,159.94 22.82 341.46 6,818.49 1,290.25 
36 2/1/2013 8,616.49 21.97 342.31 8 476.18 1,312.22 
37 3/112013 8,476.18 21.12 343.16 8,133.02 1,333.34 
38 4/1/2013 8,133.02 20.26 344,01 7,769.01 1,353.61 
39 5/1/2013 7,789.01 19.41 344.87 7 444.14 1,373.02 
40 8/1/2013 7,444.14 18.56 345.73 7,096.40 1,391.56 
41 7/1/2013 7,098.40 17.69 346.5$ 6,761.81 1.409.25 
42 B/1/2013 8.751.81 16.82 347.46 6,404.36 1,42e.o7 
43 9/1/2013 6,404.36 15.96 348.32 6,056.04 1,442.03 
44 10/1/2013 6,066.04 15.09 349.19 5,708.86 1,457.12 
45 11/1/2013 6,706.86 14.22 360.08 6,368.79 1.471.34 
46 12/1/2013 5,356.79 13.36 360.93 5,006.85 1,484.69 
47 1/112014 5,008.85 12.47 351.81 4,654.06 1.497.16 
48 2/112014 4.654.05 11.60 352.68 4,301.37 1,608.76 

Page 2 
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SALE: You :t::' pur'dluo &, 011 a l!mo basis, ~~Jbjoot 10 the tonno an<l oondlllono ol lhll COl\trac:l and security agtHmenl 
~ ~ ~ (Voi'Oclo) and ........._ c!Uct!lled below. The Vohlde b oold In 1111 pr.oom =-. IOgOihor wilh lhl URal 

Oeocripdon ol Yoar 2015 VlN 5TFUHEN2f'Xa36538" 01hM: 
Malo< Voi'Oclo Mako "'TllYOTA '"· . Uc. No.JV ... 
~ !.lodtl TllCOJo!A,~.·- ''SNow D l.laed 

~~~:::=:""'~n~~~~~~P':'~··~~odo~:"'U:~ 
~mer::,._~= if=-' goods .....,.. you ocqulre rlgh!J 10 111om .OI!in 10 c!&ys aiW wa ontor Into uu. Contract."' 1t1oy o.ra 

PROMISE TO PAY AND PAYMENT TERMS: You promle 10 ~ualt1a'pm<:ipaiii/Tlduu o1 S ~& 00 -~ · , plus 1inanco 
c:hvgo:!J -=ulng "' tha '-"Pili balance altho roll of 2.. 9'3 % per yMt tn:rn Ieday'• aaio undJ mab.wfry, F!n&nco ·~ ICCtUI on a 

36~ day buiL AA« maturny, 0< aftM ""' - """ we Qomand paymri. ,... wil um -..:. c:harJlM on the unpoJd 
baJanco a1 •' <rlt-,·~" '"opb")'M??Y~iO·pay trlo C01uUct o.a:ortllng 10 tno paymeot ~ and lalt ehargo prwtsjons """"" In 
tno TRUTH IN LeONG DtSClOSURI!S. You olso - 10 pay any I<!CIIIonlll""""-"''S acoort1ng tc IIMI tan"nl and CO<'Ollons ol this ~ 
181 MINIMUM FINANCE CHARGE: You agrao to ptrt a ITinlrrun - c:hatge of S 25.00 U )'0<1 pay lhb Con!raa In tu1 

belote Wit ha"" - lf1al nu::n ln llnanca e~~org .... 
DOWN PAYMENT: You IIIIo -10 poy, ot "''PPYIO 1t1t Cosh Prl:o, on ott>alola today'~ date, arrt ca>h,- ond r.11 nao-!n .aL>o doso'iJod 
ln tho rTSQZATJON OF AUOUNT FINANCED. D You - 10 make dltarrod paymems as pan ollho ca.sh down~ .. r.fr.cted ln 
your Paymont ~ 

~ADDITIONAL CHARGE: You og111o10 poy a procaslng f .. o/ol·' "..-! g9,1lr3·, 11\21 will be 0 pold In <=It 181 f!nanced <:Net 

tho IO<m ollho Con!ract 
TRUTH IN LENDING DISCLOSURES 

ANNUAL FINANCE AMOUNT FINANCED TOTAL OF PAYMENTS TOTAL SALE PRICE 
PERCENTAGE RATE CHARGE lhoam<>Unlolcroc!l! Tho..,.,._.-,tyou'llll'- 1l'oo- CCSiol )'O!Up.odla>e"' 
lho coot ol )'0'-" C'O<i1 .. The doOar IJ!tO<int !he fli'OVI<IId 10 you 0( Cl'l poij .==: lllVO modO C>OI.~-cbon-ol 

• yearly rata. cnodJt .... CC-'1 you. )'O<I'behaH. . . __ .. _. ·--~ s . 61111.74 '· 
--~-~ ,'!Co :S..·- J_§.~-,!10_ .. -- . Is. 2007'3. oo ~?.• S·- l!I883,-B0•·.•· ·• S·-~.54">·. 

Payment Schild ule: Your payment ocn.dtH wil ~ 
NLml>llol f'a\'mOI"ooJ Amount ol Paymool5 Whon ~~Are Dt.o 

·50 •1•.Lij ~..;. .-3!;4:-!1'3-<; ....... :.r.·Ji'IIJNTII,~ ' BE6 INN I NliP'' 06/lilS/.201 5-." .. , 

Security: You ar11 glvlnsj a oea.o!tylntorestln the lolalor VoN de purchasod. 
I8I Lote Charga: If a poymem lo more !han Jg c!&ys lola, )'OU "" "- charged fu!oero=t~l!l!~-~~m 

amout1!, no<IO oxeeed m.QQ 
Prepayment ~ you pay oil this Contr.a Nrty, you 181 may 0 ri not ~lave 1o pay a l.llrimL<n Filana! ~ 

I~ ~n:;,::;.,.,''f':, .'f: ~ re!u~ ':.~ ld<iConlllllfofrna!bn about nonpayment. <!a!autt. any roqu~rw<~ 
CREDIT INSURANCE. Credit lifo, crOOit h .. Jtn (acx:ldlt'lt and ITEMIZATION OF AMOUNT RI'IANCEO 

=~~=~<;:~==·;,"~-: Vo/W:IoPrlce'(<-d.-taxof$ !326.7! )~ ?5811.74 
an<l ,:'lj'"" 10 pa~ the l!d<illklnal pmn'U1i. n )'OU want such lnw'oncO, SaMet C0ntr10c!, PS!d tc: S NA ., 
n ob!ai1 ~ Ot you (V you~ fa< """'"'B90~ Wo or. qr..<>l!ng Czsl1 Price $ 25811 74 "-
belO* ONLY tho~ )'0<1 ..... c:t.osan to purchuo. Monulacllnr'o Reb#8 $ NA • 

cndlllJ!o: '""'rod Cosh Down ~ymenl $ .. 6! 10, 74 
D SO'Igle D Jo<nt Prom. S !IQ Term Del~ Down Porn- S N!! 

Credit Heattb: lnsu.red w ~ ,...L,•; . .; .. 't •• ··a.· Total CastV'R£bQ.te DoNn S fill 0 74 
D 5roglo D Jor.o Prom. S NO Tonn b. Tratlo-ln A.looftnce S tiA 

....... ~ 0. l:CSS:·Amou'l1 owing s NQ . 

Paldto:-=--:---:--::--:----:----::-----:-::--
d. Nel Trade-In (b. nintJI c.) 1---""'N!l"--
._ Nel CosiYTtad6-ln (o. pluo d.) S "',A 74 

~~~~~~~~·~-~~":'~~~:~ DownPuymcnt(a.:~u$01~) s 6''0 74 
arry et:Nerage:t...,. otfere:d. . Unp,Dki 8aJ:atl:ee of Cash Prlee S 1 9701 00 

Atrtooo!IO Finane. One o, (If 0. Is M!jiiiYe) $---"-NO"--
Pa!d !C f'Ltlllc Olllc:!tl!s, Inducing Mng lees 6 -,.--"'NA"--

~ lnauranca PraJTW'na paJd to Insurance N9 
compony(loo) S -~.,..,.,..,.,__ 

PROPERTY INSURANCE: You n-us~ 1Mure tllo Property !I«<Jrlng To: Pro<:ecing F8o 10 Cted1cr S -.,--l-9'3-,.,. c-00_ 

~~ ~.~~-~~ plactheod.~o ~no~ref•~any To: "= S NH 
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ftOal«lhrough'!'.~.~-.~ · NR · f?'otcMn.~ +:. v.s.I.- ! 19;...00 

Thll pramUn Is c:ala.dalod a !oUows: Total Other Chatgc&/Arnounb Pd. to Othera S · i ~: :: 
Ds __ NA __ D-,'CollsO:In ~ $ ~ L.esr. Propold Flnonco Chargn s·-...,..,..,.,-,.,..-
Ds~Oodliciblo,'~CoY:r: Nil ·- Amountl'innn=d ' 1:0019.00 
D Fn-Thoft and~ AOdltloMI eo-.g. S · AA Wo may main 0< recoM! a portion of any 4>T'oO<-"'5 'paid to OlhoD. 
D S · ' iii•" · -1 TtU Contract ~ tho! a copy of ~ bo h•nl~ 10 )'OU at tho lime 

tt lo OUCU\Od. 
Ulblltly !nainnee cov.,._ for P"BOIW Uablllty and PI'Oflarty NOTICE TO THE BUYER 
~catm>Gtootlaro!JnotlnofudedlnlhloColttractun!ea (1) DO NOT SIGN THIS CONTRACT BEFORE YOU 
ehocQdondln<l1calec!. READ IT OR IF IT CONTAINS ANY BLANK 
iBSI Gl:£ TEREST->INS8RA'N E· · '"'"'- Nc..,., 1 SPACES. (2) YOU ARE ENTITLED TO A COPY OF 

. N ·IN . C ·'YO<! m=r purooaoo THE CONTRACT YOU SIGN. (3) UNDER THE LAW, 
~ lnsu&nco u part of IIIIo we-_ You may YOU HAVE THE RIGHT TO PAY OFF IN ADVANCE 
I'IJI'Cimo the cover.go tn:rn I company ol your cholco. rauanably T H E FUlL AM 0 U NT DUE AN D UNDER CERTAIN 
oo:apcablo to ua. H )'QU buy the COYO._ from"' through'-"· yoo CONDmONS TO OBTAIN A PARTIAL REFUND OF 
wil pay I 179. !l0~·11:ii ·'' ·::o;!,"£Ml~1"'~~ THE FINANCE CHARGE. (4) THIS CONTRACT SHALl. 
0 SERVICE CONTRACT: With your purchuo of tho Vonldo, ' BECOME EFFECTIVE ONLY WHEN SIGNED AND 
""' agreo to putehase a - Con!rac! 10 COYe< : ; EXECUTED BY THE BUYER. AND SELLER. 

• BY SIGNING BELOW BUYER AGREES TD THE TERMS ON 
---,---------Thb S.n~lco Conncl,... ~In · PAGES 1 AJID 2 OF THIS CONTRACT AliD ACKNOWLEDGES 
<Ilea f« ·. . J.-. RE T F OPY~l!~CT. 

ASSJGmiENT: Th!o ecru.cs ll1d Socun:y ~Is aa\glad Bur-; M 
10 ~T.- B.W!,fno.. P.O. Box :>a-<,1-, KY 41502 , C.;,_';,:· ':::':l¥:;;;p'omhg,*"n"T.:l"'TT1r""'----"=-
lho~,pl'lono (,ii(;9,JHj)~.Thlnso9,_1omado . 

1 

D:ctndor the tetms ol 1 _.. agi-: D undar !he terms o1 : · 

lllO ASS!GN.I.1ENT BY SEI..L.ER on - 2. Dn-a~ lo maclo 
wl!h rocou -

'Bot . 

Orlgii)BI 



Phone: 

181 1 us 23 (606) 886-3861 

Prestonsburg, Kentucky 41653 ®TOYOTA Hl t~ .. 
1-877-886-3861 . ! Fax (606) 889-6499 

llbl -.. 
Soc. Sec. 

I~ \I I ,tJi 11 n n lit\:,! I I \ ~ Jll 
No. 

• I 
l'~l'; ';/ .:(~ lL Purchaser's Name Date 

! 't) flO X l;t~l} Residence 
Purchaser's Address D.O.B. Phone t,r.,r -'•' •C. · .. ,, .. t 

r•m tl .t l· i!JIJI'f ., fl'/ 1t1f. ' J.) Business 
City, State & Zip Phone 

VEHICLE BEING PURCHASED 
CASH DELIVERED PRICE OF VEHICLE $ . •(; '17 . ,-, 

PLEASE ENTER MY ORDER Q]New ocar STOCK NO. 

FOR THE FOLLOWING: o used 5] Truck 
I 

0 ;:•7 't l: ~~ / 
YEAR . 

l.'~ J I 11 Yll r:fAAE 
MILEAGE 

~' ACCESSORIES I $ 
MODEL OR 

nccr-:rl; c 
BODY I SERIES It !f~Drtn TYPE CllH\ COl\ i•lC 

COLOR TRIM I 
M.V.I. OR r, ., r~ vsr:ir·G~~t' 1··' ·· u''l ENGINE /: I SERIAL NO. .\ t., fc • ' I t 'J '- TYPE 
T08EDELIVERE81l / t 1 i' ., l F 
ONORABOUT ' ( , t • SALESMAN f'f-JH . .3 iHiliELI I 

WARRANTY DISCLAIMER I ' YI!J Disclaimer Does Apply 0 Disclaimer does NOT apply I We, the Seller, herebyexpresslydisclaim allwarranties, either expressed or implied, includi119 
any implied warranty of merchantability or fllness for a particular purpose. and we neither 

I / assume nor authorize any other person to assume for us any liability in connection 1·~th the 
Sale of the Vehicle. The Manufacturer's Warranty is not affected by this disclaimer or 
Warranties by the Seller Dealer. 
0 The only Dealer Warranty on this vehicle is the Limited Warranty which is issued with 

and made a part of this order form. 

0 AS IS: this Vehicle ls sold "as Is" by us. 

USED VEHICLE TRADED IN AND/OR OTHER CREDIT 

YEAR MAKE OF 
TRADE-IN 

MODEL OR BODY 
SERIES TYPE 

COLOR TRIM 

M.V.I. OR ENGINE 
SERIAL NO. TYPE 
I CERTIFY THE ODOMETER READING ON MY ABOVE TRADE: READS 

MILES. THE ODOMETER HAS 0 HAS NOT 0 EXCEEDED 

100,000 MILES. SIGNATURE: 

BALANCE OWED TO Cash Price of Vehicle & Accessories $ ._~I}':Jl'/ "•7 .. , 
ADDRESS 

Ill STATEANDLOCALTAXES 1 -~Ill~ . '· 
USED TRADE-IN ALLOWANCE $ I 

BALANCE OWED ON TRADE-IN Nf License, License Transfer, Title 
Reqistration Fee iC:':J ':) ,,,..,, 

NET ALLOWANCE ON USED TRADE-IN $ 1'1( 

REBATE $ Nf TOTAL PRICE OF UNIT $ -,.f t~t.~C- ' l 

CASH WITH ORDER $ \.l·)00. f· \:1 ( Transfer from ) 
TOTAL CREDIT (Transfer lo right column) s (.1(.\(1('. !i 0 TOTAL CREDIT left column $ 1·~:1(10 4'J('I 

MEMO 
Unpaid Cash Balance Due on Delivery $ ;=>":)(,~c:. . ... 

Purchaser agrees that this Order Includes all of the terms and conditions on both the face and reverse side hereof, that this Order cancels and supersedes any prior 
agreement and as of the date hereof comprises the complete and exclusive statement of the terms of the agreement relating to the subject matters covered hereby, 
and that THIS ORDER SHALL NOT BECOME BINDING UNTIL ACCEPTED BY DEALER OR HIS AUTHORIZED REPRESENTATIVE. Purchaser by his execution 
of this Order acknowledges that he hc:J.S read its terms al'\9 conditions and has received a true copy of this Order. 

~ 1 ...::::...-:-~~~~ y "'{ Vtl.ON\ ~.:-p G~ \.\.(. . 
~) 1 / t ': li'?.(ti (. 

Purchaser's Signature .~ .-3'J~t~ -~ ~ }"tri\S'f-1'1- · ~M~v..ZTI- Oate 

Accepted byMHI IN r•'iY t 11 n 
-.:;.: -- /·It () '•I Per ' ' 'J l I /' ' ' 

(Dealer) (Name and Title) 

''Tf1ank You· We Appreciate Your Business" RETAIL ORDER FORA MOTOR VEHICLE 

IF A CREDIT SALE, REQUIRED INFORMATION CONTAINED ON A SEPARATE DISCLOSURE STATEMENT IS MADE A PART OF THIS FORM 
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PAYMEN QUO E.xls 
-"' ~ "''-' > , • ,- ~ .. "' ~~ • ~ 

Aanot·tiz11tion Tnble . 
The amortization lftble at the end of this worksheet calculates the principal and Interest payment&, ending balance, 
and cumulative Interest for any 48 consecutive payment periods or a loan. 

To use the table, change the values In the lnltal Data Gecllon of the worksheet. 
+To prtnt the table, choose Print from the File menu. The print area Is set to A1 :G77. () 

/,~ ~ 

+ If yo~tlncrease the term or the loan or the number of payments, you will need to add more payment periods / 

to the table. Select cells A75:G77, then drag the Fill handle{~') Into the cells below the table. 
+ Most formulas on this worksheet are contained in defined names. To see the names and formulas, 

choose Name from the Insert menu, and then choose Defino. Select a name from the list 
('Amortization Table'llnteresl, for example}. 

Loan amount: $20,934.151 
Annual Interest rate: 2.99% 

Term In years: 6 
Payments per year: 12 
First payment clue: 311/2010 

PERIODIC PAYMENT 
Entered payment: 

Calculated payment: 

CALCULATIONS 

No. 
1 
2 
3 
4 
5 
6 
7 
8 
9 
10 
11 
12 
13 
14 
15 
16 
17 
18 
19 
20 
21 
22 
23 
24 

Use payment of: 
1st payment In table: 1 

Pny1ent 
C~1e 

"1r 4/1/ 010 ' 
5/1 .201( 

7/ /2010 "r~p 
6l /201.

1
0 

9 1/2010 it 11 12q1o 
1 11/2010 

1/1/2011 
r1112910 

2t11Zd11 
131112911 
4/1/2911 

15/1/2011 

\ f'11291 1 7/1/2011 
8/1/2611 
_9{1/20.11 
10~1/2011 
11 ,1!2d11 
12/1/2011 
1/1/2012 
2/1/2012 

S376.o7 

$376.07 

Beginning 
Bola nee 

20,934.51 
20,610.60 
20,285,88 
19,960.35 
19,634.02 
19,306.86 
18,978.90 
18,650.11 
18,320.51 
17,990.09 
17,668.84 
17 326.77 
16,993.87 
16,660.14 
16,325.58 
15,990.18 
15,653.96 
15,316.88 
14,978.97 
14,640.22 
14,300.63 
13,980.19 
13,616.90 
13,276.78 

656.917288 

Table starts at date: -or at payment number: 1 
,/ A . 

·'>-" 
-\ => .Y 

tJ 

Beginning balance at payment 1: 
Cumulative interest prior to payment 1: 

Ending 
lntoreet Principal Balance 

52.16 323.91 20,610.60 
51.35 324.72 20,285.68 
50.55 325.53 19,960.35 
49.73 326.34 19,634.02 
46.92 327.15 19,306.86 
48.11 327.97 18,978.90 
47.29 326.78 18,650.11 
48.47 329.60 18,320.51 
45.65 330.42 17,990.09 
44.83 . 331.25 17,658.84 
44.00 332.Q7 17,326.77 
43.17 332.90 16,993.87 
42.34 333.73 16,660.14 
41.51 334.66 16,325.58 
40.68 335.39 15,990.18 
39.84 336.23 15,653.95 
39~00 337.07 15,316.08 
38.16 337.91 14,978.97 
37.32 336.75 14,640.22 
36.48 339.60 14,300.63 
35.63 340.44 13 960.19 
34.78 341.29 13,618.90 
33.93 342.14 13,276.76 
33.08 342.99 12 933.77 

Page 1 

$20,934.51 
$0,00 

Cumulative 
Interest 
62.16 
103.52 
154.06 
203.80 
252.72 
300.82 
348.11 
394.58 
440.23 
485.06 
529.06 
572.23 
614.57 
656.08 
696.76 
736.60 
775.81 
813.77 
851.10 
887.57 
923.21 
957.99 
991.92 

1,025.01 

.... . 
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PAYMEN'r QUOTE.xlo 
r- Payment Beginning E!ndlng Cumulatlv& 
No. Ot~te 8alanoo Into rest Prlnclp_al Balance lnteraet 
25 3/1/2012 12,933.77 32.23 343.65 12,589,93 1,067.23 
26 4/1/2012 12,589.93 31.37 344.70 12,245.22 1,066.60 
27 5/1/2012 12 246.22 30.51 348.58 11 699.66 1,119.11 
28 6/112012 11,899.66 29.85 346.42 11,663.24 1,148.78 
29 7/1/2012 11,653.24 28.79 347.29 11,206.95 1,177.55 
30 8/1/2012 11 205.95 27.92 348.16 10,867.80 1 205.47 
31 9/1/2012 10,857.80 27.05 349,02 10,608.78 1,232.63 
32 10/1/2012 10,508.78 26.18 349.89 10,158.89 1,268.71 
33 11/1/2012 10,168.89 26.31 350.76 9 808.13 1 284.02 
34 12/112012 9,808.13 24.44 351.63 9,456.50 1,308,46 
35 1/1/2013 9,456.50 23.66 352.51 B,103.99 1,332.02 
36 2/1/2013 9 103.99 22.68 353,39 8,750.60 1,364.71 
37 3/1/2013 8.750.60 21.80 364.27 8,398.33 1,376.61 
38 4/1/2013 8,306.33 20,92 361S.1S 8,041.18 1,397.43 
39 6/1/2013 8,041.18 20.04 356.04 7,685.14 1 417.47 
40 6/1/2013 7,686.14 19.15 356.92 7,328.22 1,436.62 
41 7/1/2013 7,326.22 18.26 357.81 6,970.41 1,454.88 
42 8/1/2013 6 970.41 17.37 358,70 6,611.70 1,472.24 
43 9/1/2013 6,611.70 16.47 359.80 6,252.10 1,468.72 
44 10/1/2013 6,252.10 16.68 360.49 5,891.61 1,504.30 
45 11/1/2013 5 891.61 14.68 361.39 5 530.21 1,518.98 
46 12/1/2013 5,530.21 13.78 362.29 5,167.92 1,632.76 
47 1/1/2014 6,167.92 12.88 383.20 4,804.73 1,845.63 
48 2/1/2014 4 804.73 11.97 364.10 4,440.62 1 557.60 

Page 2 



Plll1\ ti T<JYOTR =- Buyer 
KY. f'RONT·IER 6IIS, .LLc::-...,. 

•• 1811 HIIY. US 23 N. • 
~,RRES:tlJNSBURG,·, KY- 41653 ,. 

. PO BOX. 408 .. · .. '·· .,., _ 
PRESTONSBURS, KY 41~ 'r=-1"· 

'W....OO'W'~Ihe'Sder aboYe,ltl "YO<J' and 'your" mun each Buyer allow, and 
IUCC8a50r.l 111d ns. uorar.~er · and lndMd • 

D oocriptlon ol 
Tr.!e-ln 

Year 2Q 16 • V1N ~SX!!EN26XM238:5> ~·"' 
lolak. ··• TOYOTA "';', Uc. No .!Year 
Model -:r~~!Si.Jiea 

~~~===-~rn"::"~~~~cJ!d"P':;...,.~=:::~~ 
Qu-ln!..., wll no! ---.d 1o .,....,.,. goo<t1 .n.n you ~ r1giTt> 10 !hom wlrh!n 10 day> o1ler wo ente< Into ttll c:ontr.ct. 0< !My are 
rutaicO In 0< aJfbcBd 10 1m Vot-kle. 
PROr~ISE TO PAY AND PAYMENT TEAMS: You oromJsa 1o p4y-U. lht ~ llmounl'c>l S' ·20934- :51 • ·+ . pJuo rnanca 
~ accn.rlng on 1ho L.rrpOld ball:nce at 1M 1010 of 2. 99 % por r-at from IOday'• dale untlt ~. ~ !:harg. accrue on a 

:l§!l!3§5 ~ bUro. fob( matuity, or alter you <lo!aJJII and we dornand paymon!, q ..til oam fV1once charvoo on l11a unpoud 
baJanco at ' ... 4··99. ~!lr'-¥W.~!ci~!hlo Co<Waaa~"' ll'oO psymen!- and 1010 c:IWge pro.olslono &h<Mn In 
lhll TRUTH IN LENDtNG D1SClOS\JAEB. YO<J IISo ~ lo pay any~ o:moun"' accortlng lo 11\0 IOm15- c:crrdk.lons olll>'s Cootr8ct. 
~ MINIMUIIJ ANA NCE CHARGE: You agrH lo pay a rrinffl.m flnanal r:hatge cJ $ 25.00 I you pay this Conltact In tun 
belo<o we haw oamcd !hal mudlln ~OIJ\CO Cllat;H-
OQWN PAYMENT: You eo agM 1o pay, ar ~to 1too Cosl1 Price:~ ar bolero IOdlry'l da!o. IJI'If CIS>. robata an:l rw! lrado-il \'Liuo doscrib<lcl 
In lho ITEMIZATION OP AMOUNT ANANCED. 0 Yoo ~""to rna <a 401arrod paymonta u par1 ollho cash down~ aa ro/tactod In 
your Pa)'I'Mtll Sd>odule. . . 
1:!!1 ADDITIONAL CHARGE: You - 10 pay a procusjng lee oi':f•''l'1<1:9'3>03-',1;'"-l -- will be 0 paid In C2Cil. I8l tlnanctd owt 
lh<l '"'"' cJ 11>1 Conncl. .• 

TRUTH IN LENDING DISCLOSURES 
ANNUAL RNANCE AMOUNT ANANCED TOTAL OF PAYMENTS TOTAL SALE PAJCE 

PERCENTAGE RATE CHARGE TMamoonrolcnldll Thoomoon!)OOWIIhall<! Tho tMl ""' ol """' pw<noso "" 
The COS! ol }'0\Jl' cr6dil .. Tho do low amoun1 lho pmvtdod "' you "'on poici'Oilon)OO-Ir*D O'ldl.~ywr.....,P<I)<Imlol 

ayoat~yrata. CI'O<itwill COOl you. yourbehoil!.·. 
·al~~- S:' ··~,§lg ..• 

3.37. "' $ . lB;$..29 .... - S· 20735,:!~ . . s J .. • s. ~:.s"'- .. 
Pa~ Schedule: Y,.. p<rymon11C1tac11h Wtl be ; 
~ ol Pavmont1 Arnomtol- Wilen f>oyman!l Aro Duo 

. .'· '"6.0 ... ~ ... ,.1.J " :r-!-;:trls..:· -'-"l-IIO!ff.Hl:,Y<,f. BE6INNIN6: · ·0Z/29/201 s 

Socurlty: YO<J aro glmg e !I<I<:Ul1!y i1west In lho l.lo10I Vehldo P<JSC!=o<l. 
181 Late C!tatge: U • peymontls moro 1han 10 rMyo late. you wil be cllargod f!yg O<n:cnr (~ o1 "" ~Ill!!! oavm<'fll 

lltllO<J!:!!, 1101!!! oxcoed S2S.Q2 
Prepayment: K ycu P"Y off thlt Conlroa ~. ycu f!il moy D wil not hove to pay • l.itim..., Finance ~ 
~=ls!~can:,~·~~.f~·,;:~J~~~ lniomladon l!bovl ~~ clet&uJt. any,__ 

==--t..o.lllrt............,CV 
.._..~~ ...... Orw:l,tiiS ~r1gh')al 

·:' 1 



e o a 
U .S . 23. 460 & 80 • P. 0 . Box 210 • lvel , Kentucky 41642 
(606) 200-3190, 1-688-430-9289 • Fax (606) 478-1235 

I•LEASE ENTER MY ORDER FOR THE FOLLOWING 
0 Use<J 0 Demonstrator 

s.w. 
O Car 0 Trailer 

Name of 
Insurer. CASH PRICE OF VEHICLE 

AND PROPERTY DAMAGE CAUSED TO OTHERS IS NOT INCLUDED 

OUTSIDE LIEN INFORMATION 

DESCRIPTION OF TRADE IN 
..: Y. Y.,, 

'1'!0. t)J 
Total AmotJnt Financed S ------------- For (Number of 

% Rate of lnleresl 
f tl _I./ J. 

Months) --------- at ___ .;...;..;.....;...;._ 

Monthly Payments of S G lll · l' Due at_! -" ----- of the Month 

UNLESS THE MANUFACTURER OR THE DEALER HAS ISSUED SPECIFIC WARRANTY 
ON THIS VEHICLE, SEE THE DISCLAIMER OF WARRANTY ON THE BACK OF THIS 
CONTRACT. E SECTIONS 5 ON ><t- 'vt-><s>-

1. I hereby certify that tnis order includes all the terms and conditions. on both the face and 
reverse side hereof, that this order cancels and supersedes arty prior agreement and as of 
the date hereof comprises the complete and exclusive statement of the terms of the 

ACCESSORIES 

agreement relating to the subject matters covere<J hereby, and that THIS ORDER SHALL , .... 
NOT BECOME BINDING UNTIL ACCEPTED BY DEALER OR HIS AUTHORIZED REP· I' 
RESENTATIVE;AND .liililliJi 
2. I have reviewed this order and fully understand that my new unit will be equipped only 
wilh the optional equipment specifically lis'te<J on the face of this order plus all standard 
equipment as designated by the manufacturer at time of delivery; AND 

3. All equipment (Including tires) as appraise<! on my trade in will remain. 

I certify that I am 18 years of age, or older; and that I have read the printed matter on the 
front and back hereof and agree to it as a part of this order the same as if it were printe<J 
above my signature 

sa~perwn 

S!gnad(l) i{; •! ,'.J : \ 

A&Hins. 

Ext. Ser. Plan 

This Ordet is ~~ val:d unless s!gned and accepted 
b-t the Dea'eror his au!horizad r•p<e.antative. (2) ~--:-:----_.;..---,-+-r~~-------

1/ Jt) I t • 

Da!a ------------
1 -l •• 

Dea'cr or Authorized Represeola~'ve 
SEE REVERSE SIDE FOR ADDITIONAl TERMS OF HIE SALE 

R 

L 

A 

E 

. 
" 

TOTAL 
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PAYMENT QUOTE.xls 

Atnortization ·rab.le 
The amortization table at the end or thle worksheet cetculetes the principal and intere!:it payments, ending balance, 
and cumulative interest for any 48 consecutive payment periods of a loan. 
+ To use the table, change the values In the lnltal Data section of the worksheet. 
+To print the tabla. choose Print from the File menu. ihe print area Is set to A1 :G77. 
+ If you increase the term of the loan or the number of payments, you will need to add more payment periods 

to the table. Select celts A75:G77 , then drag the Fill handle~) Into the cells below the table. 
+ Most formulas on this worksheet are conta ined in defined names. To see the names and formulas, 

choose Name from the Insert menu, and then choose Define. Select a name from the list 

('Amortization Table'llnterest, for example). fi»'3ooJ l.fJg§/-3 
WitWi filJ11Eii%i~ili~f~!J~&!b-.Tvgilt~'lf{?~~i1J'Lt!i\1&~~1#!~1\~t1i&'j\l~~~~li;J 
LOAN DATA ,..-~ TABLE DATA 

~~~~~~~~~~----------Loan amount: ( $34,149.61 Table starts at date: 
Annual Interest rate: 2.99,% or at payment number: 1 

Term In years: 6 \. _/ 
Payments per yea.r: 12 419.5179653 
Firat payment due: 3/19/2015 

PERIODIC PAYMENT 
Entered payment: 

Calculated payment: 

CALCULATIONS 

No. 
1 
2 
3 
4 
5 
6 
7 
B 
9 
10 
11 
12 
13 
14 
15 
16 
17 
18 
19 
20 
21 
22 
23 
24 

Use payment of: 
1st payment In table: 1 

Payment 
Date 

3/19/2015 
4/19/2015 
5/19/2015 
6/19/2015 
7/19/2015 
8/1912015 
9/19/2015 
10/1912015 
11119/2015 
1.2/19/2015 
1/19/2016 
2/19/2016 
3/19/2016 
4/19/2016 
5/19/2'o16 
8/19/2016 
7119/2016 
8119/2016 
9/1912016 
10/19/2016 
11/19/2016 
12/19/2016 
1/19/2017 
2/19/2017 

$613.47 

$613.47 

Beginning 
aatanco 

34,149.61 
33,621.23 
33,091 .53 
32,560.51 
32 ,028.17 
31,494.50 
30,959.50 
30,423.1 7 
29,885.50 
29,346.49 
28,806.1 4 
28,264.46 
27,721.40 
27,177.00 
26 631.26 
26,084.13 
25,535.65 
24,985.80 
24,434.59 
23,862.00 
23,326.03 
22,772.69 
22.215.96 
21 657.84 

The table uses the calculated periodic payment amount, 
unless you enter e value for "Entered payment." 

Beginning balance at payment 1: 
Cumulative Interest prior to payment 1: 

Ending 
Interest Principal Sa lance 

85.09 528.38 33,621 .23 
83.77 529.70 33,091 .53 
82.45 531.02 32,560.51 
81.13 532.34 32,028.17 
79.80 533.67 31.494.50 
78.47 535.00 30,959.50 
77.14 536.33 30,423.17 
75.80 537.67 29,885.50 
74.48 539.01 29,346.49 
73. 1~· 540.35 28,806.14 
71.78 541.70 26,264.45 
70.43 543.05 27,721.40 
69.07 544.40 27.177.00 
67.72 545.76 26.631.25 
66.36 547.12 26,084.13 
64.99 548.48 25,635.65 
63.63 549.85 24,885.80 
62.26 551.22 24,434.59 
60.88 552.59 23,882.00 
59.51 553.97 23,328.03 
66.13 555.35 22,772.69 
56.74 558.73 22,215.96 
55.35 . 558.12 21,657.84 
53.96 559.51 21,098.33 

Page 1 

$34,149.61 
$0.00 

cumulative 
Interest 
85.09 
168.86 
251.32 
332.45 
412.25 
490.72 
567.86 
643.67 
718.13 
791.25 
863.03 
933.46 

1,002.63 
1,070.24 
1 '136.60 
1.201.59 
1,265.22 
1,327.48 
1,388.36 
1.447.86 
1,505.99 
1,562.73 
1.618.09 
1 672.05 
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No. 
26 
26 
27 
26 
29 
30 
31 
32 
33 
34 
35 
36 
37 
38 
3Q 
40 
41 
42 
43 
44 
45 
46 
47 
48 

Payment 
Date 

3/1 B/2017 
4/19/2017 
5/19/2017 
6/19/2017 
7119/2017 
8/1912017 
9/19/2017 
10119/2017 
11/19/2017 
12/19/2017 
1/19/201 a 
2/19/2018 
3/1912018 
4/19/2018 
6/19/2018 
6/19/2018 
7/19/2018 
8/19/2018 
9/19/2018 
10/19/2018 
11119/2018 
12/19/2018 
1/19/2019 
2119/2019 

aaglnnlng 
Balance 

21,098,33 
20,537.43 
19,975.13 
19,411.43 
18,646.32 
18,279.81 
17,711.89 
17,142.55 
16,671.79 
16,999,81 
15,426.00 
14 860,97 
14,274.50 
13,896.59 
13117.25 
12,536.46 
11.954.22 
11,370.54 
10,785.40 
10,198.80 
9,610.74 
9,021.21 
8,430,22 
7,837.75 

PAYMENT QUOTE.xls 
Ending Cumulatlva 

Interest Prlnolped Balanoa Interest 
52.57 660.90 20,637.43 1,724.62 
51.17 562.30 19,975.13 1,775.79 
49.77 563.70 19,411.43 1 826.66 
48.37 666.11 18,846.32 1,873.93 
46.96 666.51 18,279.81 1,920.89 
45.55 667.92 17.711.89 1 986.44 
44.13 569.34 17,142.55 2,010.57 
42.71 570.76 16,571.79 2,053.28 
41.29 872.18 15 999.81 2,094.67 
39.87 673.81 16,426.00 2,134.44 
38.44 675.04 14,850.97 2,172.88 
37.00 676.47 14,274.50 2 20US 
35.67 677.90 13,696.59 2,246.45 
34.13 679,34 13,117.26 2,279.57 
32.68 680.79 12,636.46 2.312.28 
31.24 582.24 11,964,22 2,343.60 
29.78 683.69 11,370.64 2,373.28 
2S.33 685.14 10 785.40 2,401.61 
26.87 686.60 10,198.80 2,428.49 
25.41 688.06 9.610.74 2,463.90 
23.95 688.53 9,021.21 2,477.85 
22.48 690.99 8,430.22 2,600,32 
21.01 592.47 7,837.75 2,521.33 
19.83 593.94 7,243.81 2,540.86 

Page 2 
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Date ': Z · ::-2 :z .' ~ ~ 'We~ and "us" mean the Seller above, its "You" and "your' mean each Buyer above. ana 
successors and assigns. guarantor, Jointly and lrnJivfdualty. 

SALE: You agree to purchas& from us, on a time basis, subJect to the terms and conditlol18 of thJs contract and security agreema~t 
(Corrtracll. the Motor Vehicle (Vehicle) and !etVlces descnbed below. The Vehicle is sold in Its present condHion, toge!har wHh the usLsl 
accassorfes and attachments. 

Description of 
Motor Vehicle 
Purchased 

Year 
Make 

Model 

~J.:.:. 
r=-c;,:· 

VIN ';. '=~~--= ~:~37 ?~:3-53:!.;;. Other. 

Description of 
TraOO-In 

-=--~s~ 'I'::<~? 
Uc. NoJYear 
O.New Oused 

SECURITY: To secure your payment and perfonnance under the terms of thls Contract, you give us a security Interest iil the Vehte:e, all 
accessions, attachments, accessortes, and equipment placed In or on the Vehicle, together called Property, and procaeds of the ?rcpe:r.;. 
Our Interest will not extend to consumer goods unless you acquire rights to them within 10 days after we enter Into thls Contract. or t11ey ara 
installed In or affixed to the Vehicle. 
PROMISE TO PAY AND PAYMENT TERMS: You promise to pay us tile prinCipal amount Of$ · • ... ' • plus financ;) 
charges accruing on the unpald balance at the rate of' :2 •. ::c,.,r; %per year from today's date until maturity. Finance charges accrue or a 

'.3651365 day basls. After mal\.lri!y, or after you default and Iva demand payment, we will eam finance charges on the unpalc! 
balance at <' cc:: fi% per year. Y~u agree to pay this Contract according to the payment schedule and late charge provisions shown in 
the TRLJll-! IN LENDING DISCLOSURES. You~ agree to pay any additional amounts a=rdlng to the terms and conditions of this Con1:-act 
~ MINIMUM FINANCE CHARGE: You agree to pay a mlnlmum finance charge of $ 25.00 i1 you pay this Contract in fu': 
before we have earned that much In finance charges. 
DOWN PAYMENT: You also agree to pay, or apply to the Cash Prtce, on or before today's dale, any cash, rebate and net trade-in value descrl02c 
In the ITEMIZAllON OF AMOVNT FINANCED. 0 You agree to make deferred payments as part of the cash down payment as reflect.:d ·~ 
your Payment Schedule. 

181 ADDmONAL CHARGE: You agree to pay a processing fee of$ that will be 0 paid In cash. IEl financed ave-

the term ~f the Contract 

TRUTH IN LENDING DISCLOSURES 

ANNUAL FINANCE 
PERCENTAGE RATE CHARGE 
The cost of your credit as The dollar amount the 

M10UNT FINANCED 
The aroount of credit 
provided to you or on 

TOTAL OF PAYMENTS 
The amount you wOi have 
pak1 when you have rmde 
a; scheduled payments. 

TOTAL SALE PRICE 1 
The total cost or your purchase or 1 
credit, lndOOng yotE down paymert cf 1 

a yearly rate. credit Will cost you. your behalf. $ --..,.-~,..,..~'7:" ____ _ 
2. ~ % ~ 2£::'2. 'S~ s $ :.3::~.?'J $ '~:5~.?. 

Payment Schedule: Your payment schedule will be 
Number of Payments Amollnt of Payments When Payments Are Due 

c_ • . ._i.,. 
-. , .. ..: 

r----------J~-----------~-----------------------------------------------' 
Security: You are giving a security Interest In the Motor Vehicle purchased. 
J2Si Late Charge: If a payment Is more than 10 days late, you will be cllarged live percent (5%) of the swured paymen1 

amount, not to exceed $25.00 

Prepayment If you pay off this Contract early, you ~ may ClWill not have to pay a Minimum Flnance Charge. 
Contract Provisions: You can see the terms of this Contract for any additional Information about nonpayment. default, any req~;ir8d 
repayment before the scheduled date, and prepayment refunds and penalties. 

CREDIT INSURANCE: Credit life, credit health (accident and 
health), and any other Insurance coverage quoted below, are not 
requtred to obtain credit and we will not provide them unless you sign 
and agree to pay the additional premium. If you want such Insurance, 
we Will obtain it for you (if you qualify for coverage). We are quoting 
below ONLY the coverages you have chosen to purcb!t$e. 

Credit Uta: Insured-------------------
0 Single 0 Joint Prern. $ ___ ,:.•...:.:._. Term-~-'----

Credit Health: Insured-----------------------
0 Single 0 Joint Pram.$-------- Term--------

Your signature below means you want (only) the Insurance 
coverage(s) quoted above. If none are quoted, you have declined 
any coverages we offered. 

Buyer dlr:lo Buyer d/r:lo 

ITEMIZATION OF AMOUI'IT FINANCED 

Vehe!e Price (incl. sales tax of$ ' '· -; · ' ) S ------~--
Service Contract, Pald to: '' '~ $ ----~-

cash Price 5--~----
Ma11ufacturer's Rebate $ -----
Cash Down Payment $ ------
Deferred Down Payment $ " · 

a. Total Casi'I/Rebate Down $ ------'---
b. Trade-In Allowance $ ----~'-
c. Less: Amount owing $ ----""'--''--

P~dro: ___________________ ___ 

d. Net Trade-In (b. minus c.) $ --~-~-
e. Net Cash/Trade-In (a. plus d.) S -------

Down Payment (e.; dlsclose as $0 If negative) 
Unpaid Balance of Cash Price 

Amount to Finance line e. ('rt e. Is negative) 
Paid to Public Officials. Including filing fees 
Insurance Premiums pald to insurance 
company(les) 

$ 

s 
s 
s 

s 
PROPERTY INSURANCE: You must Insure the Property securing To: Processing Fee to Crecfrtor 
this Contract. You may freely choose the agent and insurer through To; •. , . 

s 
or by which your Insurance is placed. We will not refuse any 
adequate Insurance policy that you provide. The coiUsion coverage To: .. _.. 

s 
s 

deductible may not exceed $ '· ··, r:. . If you get Insurance To:~------------- s 
from or through us you will pay $ for TO:~--------------- $ 

------------------of coverage. To: ...,:c_ ___________ _ 5 
This premium is calculated as fonows: Total Otl1er Charges/Amounts Pd. to Others s 
0 S : • ; Deduc!Jble. Colllslon Coverage $ ____ _:..·"-<'~- Less: Prepaid Fln;~n~ Charges $ 
0 $ ' · • Deductible, Comprehensive Gov. $ · '~ Amount Financed s 
0 Ftre-Theft and Combined Additional Coverage $ We may retain or receive a portion of any amounts paid to othtilrs. 
0 $ This Contract requires that a copy of It be furnished to you a! the tJ-12 

Liability Insurance ~verage for personal llebillty and property 
damage caused to others is not included in this Contract unless 
checked and Indicated. 

r-1 ......... .-. - .... ---- ..... - ................. ··-- •• 

it Is executed. 
NOTICE TO THE BUYER 

(1) DO NOT SIGN THIS CONTRACT BEFORE YOl..: 
READ IT OR IF IT CONTAINS ANY BLANK 
SPACES. (2) YOU ARE ENTITLED TO A CO?Y 0:= 



ll/12/2006 8~:~~ 

Telephone (808) 886·9181 
1-800·844·91 81 

~ 
Purchaser's Name 

Purohaaer's Add ron 

City, Slate & Zip 

ACCEPTED BY 

1 G8688GbrlbtJ 

STOCK NO. 

42:998 

I"UF'SCH!::WNS 

CASH DELIVERED PRICE OP VEHICLE 

Cnsh Price o!Vehlcle &Acces~ortes 

PAGE tll./13'3 

713 South Lake Orlvo 
PreelonsbUrg, Kenlucxy41653 

$ 

TOTAL CReOIT ('fAANSI'E!MtrorROJ.lle:I"T COlUMN) $ 

UI'!PAIO CASH BALANCE OUE ON DELIVeRY $ 



PAY/v1_ENT QUOTE.xls 

A'n1ortization Tnblc 
The amortization table at the end of this worksheet oalculates the principal and interest payment$, ending balance, 
and cumulative Interest for any 48 consecutive payment periods of o loan. c\... 
+ To use the table, change the values In the lnilal Data section of the worksheet. .J~ · 
+ To print I he table, choose Print from the File menu. I he print area is sst to A 1 :077. f\J 

<\} 
• If you Increase the term of the roan or the number of payments, you will need to add more payment periods 

to the table. Select cells A75:G77, then drag the Fill handle~) Into the cells below the table. 
+ Most formulas on this worksheet are contained ·In defined names. To see the names and formulas, 

choose Nama from the Insert menu, and then choose Define. Select a name from the list 
1 
S 

('Amortization Table'llnterest, for example). (____, CJ \ 

K!K~Xt~tr~t~Et~~&~~J.~~~~-~;~t;~;~~i~~;m~J~f0~#~,!~~~:~M~u;~;t?(~~~~~r~~~~f~ii~t11fu~~t . 'i.t!#~~f~~~~R~; 
LOAN DAiA , .. -- -.) _.T....,A_B_LE.._D-..A~T_A~~:--:---:--r-----

Loan amount: ( $33,973.08 . ~···· Table starts at date: 
Annual Interest rate: 2.B9o/o--~·--·-··"' or at payment number: 1 

Term In years: li 
Payments per year: 12 
First payment due: 3/1/2018 

PERIODIC PAYMENT 

422.6891938 

Entered payment: 
Calculated payment: $610.30 

The table uses the calculated periodic payment amount, 
unless you enter a value for "Entered payment." 

CALCULATIONS 

No. 
1 
2 
3 
4 
5 
6 
7 
8 
9 

10 
11 
12 
13 
14 
15 
18 
17 
18 
19 
20 
21 
22 
23 
24 

Use payment of: 
1st payment In table: 1 

Payment 
Data 

3/1/2015 
4/1/2015 
5/1/2015 
6/1/2015 
7/1/2015 
8/1/2015 
9/1/2015 
10/1/2015 
11/1/2015 
12/1/2015 
1/1/2016 
2/1/2016 
3/1/2016 
4/1/2016 
5/1/2016 
6/1/2016 
7/1/2016 
8/1/2016 
9/1/2016 
10/1/2018 
11/1/2016 
12/1/2016 
111/2017 
2/1/2017 

vi£ 

Beginning 
13alanoe 

33,973.08 
33,447.43 
32 920.47 
32 ,392.19 
31,862.60 
31 ,331 .sa 
30,799.46 
30,265 .90 
29,731 ,01 
29,194.79 
28,657,24 
28116.34 
27.578.10 
27,03$.51 
26,493.58 
25,849.28 
25,403.65 
24,856.85 
24,308.28 
23,758.55 
23,207.44 
22,654.97 
22,101.12 
21,545.88 

Beginning balat'lce at payment 1: 
Cumulative interest prior to payment 1: 

Ending 
Interest Principal Balance 
84.65 525.65 33,447.43 
83.34 ' 526.86 32,920.47 
82.03 528.27 32,392.19 
80.71 529.59 31,862.60 
79.39 530.91 31,331.69 
78.07 532.23 30 799.46 
76.74 533.56 30.265.90 
75.41 534.89 29,731.01 
74.08 536 .22 29 194.79 
72.74_,. 537.56 28,657.24 
71 .40 538.90 28,118.34 
70.06 540.24 27 ,578.10 
68.72 541 .59 27,036.51 
67.37 642.93 26,493.58 
66.01 544.29 25,949.29 
84.86 545.64 25,403.65 
63.30 547.00 24,856.65 
81.93 548.37 24,308.28 
60.57 549.73 23,758.55 
59.20 551 .10 23,207.44 
57.83 552.46 22,654.97 
56.45 553.85 22,101 .1 2 
55.07 555.23 21,545.88 
53.69 . 566.62 20 989.27 

Page 1 
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$33,Q73.08 
$0.00 

Cumulative 
Interest 
84.65 
167.99 
250.02 
330.73 
410.12 
488.19 
564.93 
640.34 
714.42 
767.16 
858.57 
928.63 
997.35 

1,064.71 
1,130.72 
1.195.38 
1,258.68 
1,320.61 
1,381 .18 
1,440.38 
1.498.20 
1,554.65 
1,609.72 
1,683.41 

'\ 
r-·: 



. -..s l v'J f./.~ 

PAYMENT QUOTE.xls 
PDyment Bag Inning Ending Cumulative 

No. Date Balance lll!$rElS! Ptlnolpal Balanoa In West 
26 3/112017 20,989.27 52.30 568.00 20,431.27 1,718.71 
26 4/1/2017 20,431.27 50.91 569.39 19,871.87 1,766.61 
27 5/1/2017 19 871.87 49.51 560.79 19,311.09 1,816.13 
26 6/1/2017 19,311.09 48.12 562.18 18,748.90 1,864.24 
29 711/2017 16,748.90 46.72 663.68 1B,18o.32 1,910.96 
30 6/1/2017 16.185.32 45.31 564.99 17,620.33 1,956.27 
31 9/1/2017 17,620.33 43.90 566.40 17,053.93 2,000.18 
32 10/1/2017 17,063.93 42.49 587.81 16,486.12 2,042.67 
33 11/1/2017 16,486.12 41.08 669.22 15 916.90 2 083.75 
34 12/1/2.017 1o,e1e.so 39.66 670.64 16,346.26 2,123.41 
35 1/1/2018 15,346.26 38.24 672.06 14,774.20 2,161.64 
36 21112018 14,774.20 38.81 573.49 14,200.71 2,198.46 
37 3/1/2016 14,200.71 36.36 674.92 13,626.79 2,233.84 
38 4/1/2018 13,625.79 33.95 578.35 13,049.44 2,287.79 
39 6/1/2018 13,048.44 32.51 577.79 12.471.66 2,300.31 
40 6/1/2018 12,471.65 31.08 679.23 11,8Q2.43 2,331.38 
41 7/1/2018 11,892.43 29.63 680.67 11,311.76 2,361.01 
42 8/1/2016 11,311.76 28.19 562.12 10,729.64 ~!.389.20 
43 9/1/2018 10,729.64 26.73 683.57 10,146.08 2.415.93 
44 10/112018 10,146.08 25.28 585.02 9,661.06 2,441.21 
46 111112018 9 661.06 23.82 586.46 8 974.88 2 465.04 
46 12/1/2018 8,974.68 22.36 587.94 8,386.64 2,487.40 
47 1/112019 8,386.64 20.90 589.40 7,797.24 2,608.29 
48 2/1/2019 7 797.24 19.43 590.87 7 206.36 2 527.72 

Page 2 
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Ytru 2DI.S VTN 1GC2KUEGXFZ1429SB Other. 
Make o-mlet . 1,9 No.ffut . 

~ol 
Tn>Oo-ln 

Modol sa-.a, 2!iiXl 4WD Vl!2l N'a 0 u-1 

~~d:.~=~~:ll~=~~~f"'~p~~=::::~=:. 
=':,st0;•:~ = ~=-r ~ llnl"" you~ rl~ to~ ..mn 10 da'(O a/1M wo enter Into this Conlrld. or they are 

PROWSE TO PAY AND PAYMENT TERMS: You promise to pay us the prlnc!poJ lmOU'1l o1 S D!flJ.!lB , ptu1 fitwl<:e 

chorgeo occn.W'lg on the unpUl o.Jance a! !he rato ol 2.99 % por year from ll:>doy'o dolo unli maturity. FVtuoce oh~ IICO'IJ& on a 
38:!jlS5 .-y IWIJ. Mil< ITWI.IIIy, or - )'O'J dor..u~ and "" Oomand poymanl. ,.. w11 oam unaia Cll:IJ'ljoo on ttoo u~ 

balance a! 
4 09'3 % por ~. You ogroo lo poy IIlio Contract o.ccorcing to !he poymont ochedulo ond lo!e cllarB" prtNiofona ol'mon In 

1ho TRUTH IN LENDING OJSCI..OSURES. You olio - to poy ony - ..,..,...,., oa:ordng \0 tho terms ont1 ~ o/11'1!1 COntnld. 
l8l MINlMUM FINANCE CHARGE: You agroe to pay a nr.JmJm f""""'" a.rge o! $ · !!S.QO H you poy ll1lo ContiK1 ln luD 
bolero ,.. have eamtc1 lhal much In lln&nce eha'geo. 

DOWN PAYMENT: You olao - 10 pey, or apply 1:> llo Cooh Price. on or botoro tldoy'a dolo, 1lnf cmh. - and rt111Rdo-ln ..U. deSC!'o!lOd 
In 1ho rTB.IIZATlON OF AMOUNT RNANCEO. 0 You - to make -rred paymlt'D as past ol ~ casll down paymon< u rw1'lec!ed In 
ywr~-

1&1 ADD!TlONAL CHARGE: You agreo to pay a procosa;ng loo ol i 32S .DO lha! will be 0 paid 11 cash. ~ flnancad OYe< 

the term d tho Connct. 
TRUTH IN LENDING DISCLOSURES 

ANNUAL FINANCE M'O.JNT FIN.W:ED TOTAl OF PAYMENTS TOTAL SALE PRICE 
PERCENTAGE RATE CHARGE Tha amount ol cro<l~ Tha"""""")'OIJ\OIIha\10 Tho - coot ol your putCI\>$0 '"' 
Tho c:cst ol )'OUT c:r!ld~ ... Tho <lolar amc>Jnt ttoo ptOYided to )'OU 01 on 

~~== crodl. rco.d'>g-oo..>-ol 
·~rail. er.d!l wll cort )'OU. 'fO'J(behalf. 

S ~.ZS!IW 3.23 '1. s 2.843.92 s 33,77~,08 S 36.GIB.DO s .'!t.AllO 
Payment Schedule: Your poymen! schodu!O wll bO 
Numbot ol Paymon\1 ~ol....,.,_ns Whon Paymonta Aro Duo 

60 610.30 lob'IHy llog71ing 03ftl]/;l)1S 

Security: You .,. gMr-og a 080Jrlly lntorws1 In the Motor Vohlde pult:hased. 
181 Lola Chorg&: tl a~ Ia""'"' tlt3n 1Q days ~. )'O'J w[J be chalyed ~ oe<C0<1I (§l!ll1! !!!! -.,..,.,. 

.-noum. !:!2! lo """""" ~-~ 
Prepayment: H you pay oil thla Connct owly, you 181 may 0 wll nat t12vw 10 pay a ~ Flnan:a Charge. 

I~ ::;,'t.,on.~ ~ .,';d" ~~~ ~tiono!lriormaUon at>ou1 ~nt. delau!t. Itt'/ roqtired 

Cnxl~ Lila: lf\SUT'Od _ __ciCJA=---==-------::-;: 
0 Slnglo 0 Joln1 Prwn. i --,-.,---'-'N/,,A,T~m~ ___ ..~.:N'""IA 

ITEWIZATION OF AMOUNT FINANCED 
Vol'klo Pl1ca (l1c!. oaloo tax o1 $ 1.884.j;S 38l)46ll8 
Satvtce ~ Pakl ro: _ _,Nl="-"---- S ---==;::N';!{A 

Cut! Prloo S 38.1>1§,1)8 

t.tanulaC!Uiwt• - ' ~.730.00 Cas11 Down Paymont $ ____ --::OIJ!J 

0-Dawn P>;<ner<t i 0.00 
a. Total CU!1IReb>Je Down Credit Hoallh: ----'"=•----,=-----~ 0 Single 0 Joint p,__ S ---"'N"'IATorrn ___ _,_,Nw:/A b. Trado-ln A1awanco S ____ _,N/A 

4.751?.00 

c. Less: Atnoun1 owing S N/A 
1'8<110: _____________ -::-_ 

d. Nti!Tr&<lo-ln (b. m1rus c.) 0.00 
a. N<ll Casi\IT~n (o. p6.JS 0.) S .,-.,--"-:P.L:O._,.um~ 

c~::;~.;~.~~~~a~o.';_w=~tht!,..lns~= Down~(o.;Wolosc>IUSOI,.....,..) S •.7311.00 
Itt'/ C0'<0/1.geo we ollored. Unpold Balanc. or Cash Price s 33.296.!lB 

Atrootrt to Fln"""" l!ne 11. (! o. Ia nagaiiYo) $ D .00 
Paid to Pub&J O!f1dalo, lnc!ud!ng Jiing- S ll,QO 

<>'l>b lrmlm>al Promlum3 pPj 10 "'""""""' 
compony(U) S -----'N"i/A 

=~ Y~~~ ~ ""-':. w-.u.e ~= = To: Proc!p!ng Feo to Crodltor s ___ .....J,t::t:99'::nouu 
or by wlllch your lnauraoc.,rJa placod."?r." will not ralua.e any To: ~"""!L!!J S ~ 
adaqua!8 1nout>.nce policy tMt you prOYido. Tho - """"'"00 To: L S ------.:;;g:;,;:W 
clo<!udtlla my not a>:r::Md S {'~ N{t;),_'fOU gat lnsurarico To: S -----;7799:00:00 
trcwn or 111~ us you lOri! pay$ 1o< ___ To: S -----
________________ o1 """""'!l0. To: $-----::= 

This ~.e""'"'t.d as r- Total Other Chargu/Amounta PO. to Othors S filZIJ!J 
Os-...hDodt.odllle, Co111s1on eov.raga s ____ ,N/rr,A Lno: "'-Pelcl Flnon= Char- S 19'3.00 
Os __ ._.,nlJodu;lillo.~Cov.$ N/A AmountF!nanced S 33.V4.0S 
0 f1ra. Tholt and Combined Addlr:lonal Cowrogo $ N/A Wa rn.y rotaln or roc:oMi a p6itlon o1 orrt ornou'\!1 pold 10 oth<l~ 
0 $ N/A Thbf Contrad raqu!rH tt;al a COf'1 ol ~be ft.n'iahed \0 )'tl'J al,;., trno 

Liability lnsuraoa c.,_ for porsonoJ tlablltty and ptOperty 

damago CllUSOd to otherol Is notlncluc!oclln IIU Contract um.n 
checi<ad and lnc!lcata<l. 

Q&JNGLE·INTEREST INSURANCE: You fmlOI purchaaa 
~n<aru< ~ u pan ol thla cata tninActlon. You may 
purclluo lha CC'IOtllgo from a ~ ol your cl'dca, reuonobly 
acooptab!o to us. II you buy the COYef&Q8 from or through US. )'DU 

wllpayS "'-"' lol 60 - olcoverogo. 
0 SERVICE CONTRACT: With your puld>aA ol UWt Vohldo, 
you ogroe to ~ a 5omco Conlracllo cover-----

----------·· Thlo- Conttacl wil b<lln 
~9di~---------------L----------~--~ 

~ laoucuted. 
NOTICE TO THE BUYER 

(1) DO NOT SIGN THIS CONTRACT BEFORE YOU 
READ IT OR IF IT CONTAINS ANY BLANK 
SPACES. (2) YOU ARE EN11TLEil TO A COPY OF 
THE CONTRACT YOU SIGN. (3) UNDER THE LAW, 
YOU HAVE THE RIGHT TO PAY OFF IN ADVANCE 
THE FULL AlilOUNT DUE AND UNDER CERTAIN 
CONDmONS TO OBTAIN A PARTIAL REFUND OF 
THE FINANCE CHARGE. (4) THIS CONTRACT SHALL 
BECOME EFFECTIVE ONLY WHEN SIGNED AND 
EXECLJTED BY THE BUYER AND SELLER. 

BY SIGNING BaOW BUYER AGREES TO THE TERMS ON 
PAGES 1 AND 2 OF THIS CONTRACT AND ACKNOWlEDGES 

RECI:IPT OF A COPY OF THIS CONTRACT. 



I 
Phone· 

181"1 us 23 (606) 886-3861 

Prestonsburg , l<en tucky 41653 OYOTA f ·.::. 1-877-886-386 'I 

II : Fax (606) 889-6499 
~ 

Soc. Sec --'" 'tl!• •• r 1;1, 1 r I' i.H . ll. No. 
I" G I I : /~l . 

Purchaser's Name Date 

l'f• II! X •• t i:· Residence 
f..n(, l'f,r. :··· "1 Purchaser's Address D.O. B. Phone 

Ph• ~:1 1>J HI Jpi_., l' '· ·1 '111 ' Business 
City, State & Zip Phone 

VEHICLE BEING PURCHASED 
CASH DELIVERED PRICE OF VEHICLE $ 

J /·~ l/ . i ) 

PLEASE ENTER MY ORDER ~ New ocar STOCK NO. 

FOR THE FOLLOWING: o used KJ Truck , 'j(" 

/ 0 f • , • 

YEAR ... f(•:f] I ,~KE MILEAGE Jr.; / \1,~: 4 

ACCESSORIES $ 
MODEL OR IPrt;;.:n 

BODY 
'+'(I) ntcr~·,;; / SERIES TYPE 

COLOR ''ll: 1Ll--' 1·1Hlt' TRIM '' X• 1 1)1 I : :•~:; / 
M.VI OR If! I /')fJjl~~~ \',)ft .'<l:);' ENGINE lJ t / SERIAL NO. TYPE 
TO BE DELIVERED · • 'Ill(;!··-,:~ It l rW f'· HO! 1Lf I 

....... 
ON OR ABOUT ' ' . " SALESMAN 

WARRANTY DISCLAIMER 
..-, /"" ""' \~ 

0 Disclaimer Does Apply 0 Disclaimer does NOT apply ) \ 
We, the Seller, herebyexpresslydiscla•m all warranties. e1U1erexpressed orimpUed. including 
any implied warranty of merchanlab11ily or fitness for a particular purpose. and we neither 
assume nor authorize any other person to assume for us any liability in connection •.-Ath the 
Sale of the Vehicle. The Manufacturer's Warranty Is not affected by this disclaimer or 
Warranties by the Seller Deafer. 
0 The only Dealer Warranty on this vehicle is the Limited Warrant'( which is issued with 

and made a part of this order fom1. 

0 AS IS: this Vehicle is sold "as is" by us. 

USED VEHICLE TRADED IN AND/OR OTHER CREDIT 

YEAR MAKE OF 
TRADE-IN 

MODEL OR BODY 
SERIES TYPE 

COLOR TRIM 

M.VI.OR ENGINE 
SERIAL NO. TYPE 
I CERTIFY THE ODOMETER READING ON MY ABOVE TRADE READS 

MILES THE ODOMETER HAS 0 HAS NOT 0 EXCEEDED 
IJflt:l,i'IUI!I!Ii.' t·t : i.- I )' . ' ' 

100.000 MILES. SIGNATURE: 

BALANCE OWED TO Cash Price of Vehicle & Accessories $ ' T' 11 Jt • tl l 

ADDRESS 
' h':""'f . ·'' 

USED TRADE-IN ALLOWANCE s ' STATEANDLOCALTAXES 

BALANCE OWED ON TRADE-IN I' i License, License Transfer, Title j 10( I ·: 
NET ALLOWANCE ON USED TRADE-IN s lit 

Reqistration Fee 

REBATE s II I TOTAL PRICE OF UNIT $ •· .'~·2c I t,t, 

I' , 
( Transfer from ) CASH WITH ORDER $ I I 

TOTAL CREDIT (Trans fer to right column) s • I TOTAL CREDIT left column $ ,I(~ 

MEMO 
Unpaid Cash Balance Due on Delivery $ 273,·:; . ' . 

Purchaser agrees !hal this Order includes all of the te rms and conditions on both the face and reverse side hereof, that this Order cancels and supersedes any prior 
agreement and as of the dale hereof comprises the complete and exclusive statement of the terms of the agreement relating to the subject matters covered hereby, 
and I hal THIS ORDER SHALL NOT BECOME BINDING UNTILACCEPTED BY DEALER OR HIS AUTHOR IZED REPRESENTATIVE. Purchaser by his execution 
of th is Order acknowledges that he has read its terms and conditions and has received a lrLte copy of this Order. 

/ ) / "'% '- // \ r:: '~it.'; ·•,II f 
Purchaser's Signature / ·- /..,r ?~~~ _.,./;?--;-. ·,-(£ Date 

thiN~! I !lt' ll':~ . 
I : 

Accepted by Per If ' 
(Dealer) (Name and Tille) 

'Thank You- We Apprecrate Your Bus11Jess" RETAIL ORDER FOR A MOTOR VEHICLE 

IF A CREDIT SALE, REQUIRED INFORMATION CONTAINED ON A SEPARATE DISCLOSURE STATEMENT IS MADE A PART OF TH IS FORM 



• Jan/1 9/201l ll ::r7 :2n /\M CTB Prestonghurg C-J()() .(ll!G-flr·;n 1//. 

PAYMENT QUOTE.xls ) .. (j \ .• , ' \rq \' t.:.t C•J ,,. •. •\ • 

Antortization 'fnble 
The amortization table at the end of this worksheet calculates the principal end Interest payments, ending balance, 
and cumulative Interest for any 48 consecutive payment periods of a loan. 
+ To use the table, change the values in the lnltal Data section of the worksheet. 
+ To print the table, choose Print from the File menu. The print area ts set to A 1 :G77. 
+ If you Increase the term of the loan or the number of payments, you will need to add more payment periods 

to the table. Select cells A75:G77, then drag the Fill handle {J'} Into the cells below the table, 
+ Most formulas on this worksheet are contained in defined names. To see the names and formulas, 

choose Name from the Insert menu, and then choose Define. Select a name from the list \ ( 
' \., I .-

('Amortization Table'llnterest, for example). v'V 

Loan amount: $27,600.68 
Annual Interest rate: 2.99% 

Term In years: 5 
Payments per year: 12 
First payment due: 3/1/2010 

PERIODIC PAYMENT 
Entered payment: 

Calculated payment: 

CALCULATIONS 

No. 
1 
2 
3 
4 
5 
6 
7 
8 
9 
10 
11 
12 
13 
14 
15 
16 
17 
18 
19 
20 
21 
22 
23 
24 

Use payment of: 
1st payment in table: 1 

Payment 
Date 

3/1/2010 
4/1/2010 
5/1/2010 
6/1/2010 
7/1/2010 
8/1/2010 
9/1/2010 
10/1/2010 
11/1/2010 
12/1/2010 
1/1/2011 
2/1/2011 
3/1/2011 
4/1/2011 
5/1/2011 
6/1/2011 
7/1/2011 
8/1/2011 
9/1/2011 
10/1/2011 
11/1/2011 
12/1/2011 
1/1/2012 
2/1/2012 

$496.43 
$496.83 

$496.43 

Beginning 
Balance 

27,600.68 
27,173.02 
26,744.30 
26,314.51 
25,883.64 
25.451.71 
25,018.68 
24,504.60 
24,149.43 
23,713.17 
23,275.83 
2~.837.39 
22,397,66 
21,957.24 
21,515.52 
21,072.70 
20,628.78 
20,183.75 
19,737.61 
19,290.36 
18,841.99 
18,392.51 
17,941 .91 
17,490.19 

537.1845825 

TABLE DATA 
Table starts at date: 

or et payment number: 1 

The table uses the calculated periodic payment amount, 
unless you enter a value for "Entered payment." 

Beginning balance at payment 1: 
Cumulative Interest prior to payment 1: 

Ending 
Interest Principal Balance 
68.77 427.66 27,173,02 
67.71 428.72 26,744.30 
66.64 429.78 26 ,314.61 
65.57 430.88 2o,883.64 
64.49 431 .94 26.451.71 
63.42 433.01 25,018.69 
62.34 434.09 24,584.60 
61.26 435.17 24,149.43 
60.17 436.26 23 ,713.17 
59.09 437.34 23,276.83 
58.00 438.43 22,837.39 
56.90 439.53 22,397.88 
55.81 440.62 21,957.24 
64.71 441.72 21.515.52 
63.61 442.82 21 ,072.70 
52.51 443.92 20,628.78 
51.40 445.03 20,183.75 
50.29 446.14 19,737.61 
49.10 447.25 19,290.36 
48.07 448.36 18,841.99 
46.95 449.48 18,392.51 
45.83 450.60 17,941.91 
44.71 451 .72 17,490.19 
43.58 452.85 17,037.34 

Page 1 

$27,600.68 
$0.00 

Cumulative 
Interest 
68.77 

136.48 
203.12 
266.88 
333.18 
396.59 
458.93 
520.19 
580.36 
639.45 
697.44 
754.34 
810.15 
864.86 
918.47 
970.98 

1,022.38 
1,072.67 
1,121.85 
1,169.91 
1 216.86 
1,262.69 
1,307.40 
1,350.98 



.Jan/'1!-l//.01 I ll::li:?.C) /\ivl C m Prf!l'ltonsbllriJ ()()~ lliH"l !l(i/? 

PAYMENT QUOTE.xls 
Payment Beginning Ending cumulatlvG 

No, Date Balanoa Interest Principal Bnlanoe Interest 
26 3/1/2012 17,037.34 42.45 463.98 16,583.36 1,393.43 
26 4/1/2012 16,683.36 41.32 455.11 16,128.26 1,434.75 
27 6/1/2012 16 128.25 40.19 466.24 16,672.00 1 474.93 
28 6/1/2012 16,872.00 39.05 467,38 16,214.62 1,513.98 
29 7/1/2012 16,214.82 37.91 468.62 14,756.10 1,551.89 
30 8/1/2012 14,766.10 36.77 469.66 14,296.44 1,688,68 
31 9/1/2012 14,296.44 35.62 460.61 13,836.83 1,624.28 
32 10/1/2012 13,835.63 34.47 461.96 13,373.86 1,658.76 
33 11/1/2012 13,373.88 33.32 463.11 12,910.67 1 692.08 
34 12/1/2012 12,910.67 32.17 464.213 12,448,31 1,724.25 
35 1/1/2013 12.446.31 31.01 466.42 11.980.89 1,755.28 
36 2/1/2013 11 980.89 29.85 488.58 11,514.31 1,786.11 
37 3/112013 11,514.31 28.69 467.74 11,046.67 1,813.80 
38 4/t/2013 11,046.67 27.62 468.91 10,677.87 1,641.33 
39 5/1/2013 10,577.67 2B.36 470.07 10,107.69 1 887.68 
40 6/1/2013 10,107.69 26.18 471.26 9,636.36 1,892.87 
41 7/1/2013 9,636.35 24.01 472.42 9,163.93 1,916.88 
42 8/1/2013 9,163.93 22.83 473.80 8 690.33 1,939.71 
43 9/1/2013 8,690.33 21.65 474.78 8,216.6ei 1,961.36 
44 10/1/2013 8,218.66 20.47 475.96 7,739.69 1,981.83 
45 11/1/2013 7 739.69 19.28 477.16 7 262.46 2 001.12 
46 12/1/2013 7,262.46 18.10 478.33 6,784.11 2,019.21 
47 1/1/2014 8,784,11 16.90 479.53 6,304.69 2,036.12 
48 2/1/2014 6,304.69 16.71 460.72 5 823.87 2,051.83 

Page 2 



SOller Buyer 
ICRNN TOYOTR.. KENTUCKY. FR!l'ITl ER GAS,. U.C. 
1811 HIIY US 23 N.. PC. BOX .4118.- , ~ .. •· 

- PRESIIINSBURG,~KY. 41~ · PRESTONSJlURS, KY 4!b53 · ·' 

-'-"We"--.d "u1"'mNn tlie<Solor abovo,l!o "You" and "you(' moan or.dl 
5UCC8S!JOtl end and 

Doscriptlon ol 
T<UHn 

2017 
TOYOTR · •. 
T~· 

.,. .. 

~~~~~: .. tt;:r:,~~~oJ:d"~~=::an:=~ 
~="'~=~goods unless )'O<J acqu>-e righla to !hom wilhk11 o days o.llor we onto< lnlo !I'll Con!rKt. Ot' !My are 

PROMISE TO PAY AND PAYMENT TERMS: Yoo ~~to pay ua lhe pmdpal ~ o1 S 27f.01:1. 6S .. , plus !1nonco 
ctwges occrulng on the unpold balanco !lithe - ol % per year !rom today'o dote unlil moi1Jijty, Fkwlco c:1W90> accruo Ot> o 
~ doy bam. Aile< matJJr11y, or o.tiN )'O<J - lnd we o'mnd payn.n1, wo wll oam - ~ on tho ~ 

Mlanco .1 4• 99 · ,.·perYeiiJ. vi>u'agr&. 10·p.y Ills~ Uoorning"' 111e poyment od>e<Uo ordlale ~ prtl\'blon3- in 
fte mllTH IN LENO!NG DlSClOS\.JRES. You oiSo agree 10 pay at!)' addl!!onal """"""' OCCOidlng 10 'Ill ll1'mS lnd oorwillono ct tlliO Conuac!. 
C!:J MINIUUM FIHANCE CHARGE: Yoo ·~ 10 pay o mlritrum ftnanee chotge ct $ 25 00 ~ you pay ll\lo Con!rK1 In lui 
be/oro we l-ave oamod thai rTlJeh In fNnca c:hllrgco. 
DOWN PAYIIENT: You aloo -10 poy, ot 1WY 10 lito Casn Price, on 0< bolero ICdoy'o Cll!tl, at!)' cos!>.- and nee ti'UdH1 YD.JO ~ 
n 1M ITEMIZA noN OF AMOI.JNT FINANCED. 0 You •1!'11 to mal<o dolorrod poymon!a aa part of tn. caJh down ~ u rollec!eO In 
)'01.1" ~ Schodula. ' 
~ADDITIONAl. CHARGE: You agroo to pay o p<tl085S!ng lee ct a ·'·" L99• 00 "'' ' lhlll w11 ~ 0 po1c1 n cas~>. ~ fNrcod"""' 

!he tam of tho Contraol. 
TRUTH IN LENDING DISCLOSURES 

ANNUAL FINANCE MlCJUNf AI'WIICED TOTAL OF PAYMENTS TOTAL SALE PRICE 
PERCENTAGE RATE CHARGE Tlla IIITlOUr< ol croatt ThollmOl.l'll)<l<J .... - Tl'J.I; toCI.I Ql$1 o1 your pu~ <rl 

Tho cost ol yo..- ct0d!lll3 Tha dol lor omoont ttl& 

~=or~' '~~;;;:-
Ctd, lnct.l:llngyox.-o-<J 

• )'!!'J!y rma. CI"'<fitw!llcost you. $' 8.00.·"" 
-' •. '3 • .28:::..:·.>.~; ·'S"·-'· .i2384.1'2. • .. ', ls;."'~*- 68 1~ 29785.ae i :m!!S. !lil 

Po~t Schedule: Your_~ schedule wil be 
Nu'nber ol P0y!Tl01\l0 Amour-l ol p..,..,.,. Wlwl P..,.._...llro Duo 

' '• 60 o·. ' .... 4'36. 7f3 ' "~.: . ..,.;.~\'1; •BEBINNINS: 01-/2t/21l17 

Security: Yoo are ~g • RCU!1ty -In 1h1 Motat Vohldo poo;haaod. 
181 late Charge: 11 • paylMfllis more than 1lL days 1811, you ..a bo chaf90<1 !l:!!IPOfC<II\l~oi~-DOvm&m 

omoun1 !lQ! 10 exceed ~00 
Prepoyment: U you poy olt !tEo eontr.c1 eotty. you f8l m8'f D ¥oil not '-'> 10 pay a Mlnln>.rn Fhanca Chorgo . 

. ~ ~~~"".?.:'."~ =:.n~=-~%:>'~ lntom'latlon abou1 n~ dmurt. any roq\iro<l 

Credit Lila: II'ISUI'ed _____ ...,:--------
0 Single D Join! Prom. S -.,........;NA=;-_Toon ---
~H~~~-----~~~-~-----D Slnglo 0 Jo/nl Prom. s ---'NA:.::o.._ Term ___ _ 

Uoblllty lnsuronca COYeBg• lew per30n11 lloblllty and pn>party 
aomag. caused to otherl to not lncklclld In thlo Contnct unleu 
<:h<>cbld ond lndlc:tted. 

~INGLE:I~EREST 'rf.isuRA~Nc'E:· vc:,;'.,;;i;~ ·P.,~-h~ 
Lilglo-Wor.., nouranao u pan o1 lhlo salo tnlnaclcn. Yoo m8'f 
ptXChuo lhl CCYO~gl from 0 Cll1T!p&lly ol )'OIJ1' cmloo, ~ 

oa:aptable 10 ""'1'4~ buy ~-~~.ugh. !-It, 'f<"! 
'Mlpay$ • Ia< ' Of~ 

0 SERVICE CONTRACT: With your purct=o ollhe Vcll!clo, 

)'OU - to pUlchuo • - COntract to Ct:Nef ------

----------· Th<o SeMel Contract Will be In 

·"~~-------------------
ASSIGNMENT: Tl'Oo Connct 111<1 Socuri!y ~is -ld 
to ~TMII:B.a:nk,~P.O.Bo.r2N7,Pr&l"r'tla,KY41502 
!too Anrr-. phono 8130=433=699,8 'Thlos ~ b ~ 
c:J1k1<1or !too 1orms o11 ~ o~l D undot thltonns ol 
lho ASSlGNMe/T BY sa.LER '"' 2. D n-q osslgnt1w< lo mado 

=~~ ... ~~ 
Wlllln~~~01~,.. 

NOTICE TO THE BUYER 
(1) DO NOT SIGN THIS CONTRACT BEFORE YOU 
READ IT OR IF IT CONTAINS ANY BLANK 

. SPACES. (2) YOU ARE ENTITLED TO A COPY OF 

~~ ~~R~CJ ~~~'i'J~oN.p~f g~~~ ~~A~tE 
THE FULL AMOUNT DUE AND UNDER CERTAIN 
CONDmONS TO OBTAIN A PARTIAL REFUND OF 
THE FINANCE CHARGE. (4) THJS CONTRACT SHALL 
BECOME EFFECTIVE ONLY WHEN SIGNED AND 
EXECUTED BY THE BUYER AND SELLER. 

BY SIGNING BElOW BUYER AGREES TO THE TERMS ON 
PAGES 1 AND 2 Of THIS CONTRACT AND ACKNOWLEDGES 

RECEIPT OF A COPY OF TlllS CONTRACT. 

~ ~~.#D..-.::-.V &;,....s- ~9""· 
~~ -e..~!2/06/2016 

SllnKEiffii(iy IER liAS, LLC. O.ie 

Date ~ 

So!lor. By ___::~=if'/ O£l.rA4.4.Jo IL-<..1 -'.:J~~~~~~L;;-----:"'-"""'"=:c--" 
.............,.,., 

~1CJI% Orlgin;~l 




